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1. Introduction 

This guide introduces the graphical interface for the Surflex-Dock plugin for PyMOL. For help with other BioPharmics™ 
features and operations, please refer to the Surflex Manual. For help with PyMOL features and operations, please refer 
to the PyMOL documentation. 
If you have any questions, please feel free to contact support@optibrium.com.  
  

https://optibrium.com/BioPharmics/Surflex-Manual
https://pymol.org/dokuwiki/doku.php?id=tutorials
mailto:support@optibrium.com
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2. How do I… install and run Surflex-Dock in PyMOL 

2.1 Pre-requisites 

To install the Surflex-Dock plugin for PyMOL, you will need the following: 
A working copy of PyMOL version 3.1 or newer, bundled with Python version 3.10. 
A license for Surflex-Dock. 
The Surflex executables from the Optibrium website from the BioPharmics menu on the left (v5.211 or newer). 
The tar.gz file for the Surflex-Dock plugin for PyMOL from the Optibrium website (version 1.0.5 or newer). 

2.2 Installation 

To install the Surflex-Dock plugin in PyMOL: 
Select Plugin Manager under the Plugin menu in PyMOL to launch the Plugin Manager. 
Select the Install New Plugin tab at the top of the Plugin Manager. 
Select Choose File. 
 

 

Browse to the location on your computer where you saved the tar.gz file for the Surflex-Dock plugin (you do not need 
to unzip the archive) and click Open. 

A pop-up window will ask you to confirm the directory where the plugin will be installed. Keep the default and click 
OK. 

A pop-up window will confirm that the plugin has been installed. Click OK and close the Plugin Manager. 

https://www.pymol.org/
https://www.python.org/
https://optibrium.com/products/product-installation/
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To open the Surflex-Dock plugin: 
Select Surflex-Dock under the Plugin menu in PyMOL.  
 

 
 
The first time the Surflex-Dock plugin is opened, a 
wizard will help you configure the plugin to use the 
Surflex executables and license. You will need to 
know the location of the Surflex executable files 
(sf-tools.exe and sf-dock.exe) and the location of 
your Surflex license (surflex_bin.lic). See Section 
2.1 for information about how to obtain the 
executable and license files. 
 
To configure the Surflex-Dock plugin: 
Click Next on the Setup Wizard. 
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The setup wizard first looks for the Python 
packages required for the plugin and will install 
them if necessary. Please note that you will need 
to be connected to the internet during this 
process. The Python dependencies for the plugin 
will be shown in the setup wizard and are listed in 
the file requirements.txt inside the tar.gz archive. 
(Note: there is no need to extract the archive 
before installation; everything can be handled 
through the wizard.) 
Click Install Dependencies to have the wizard 

download and install the required packages. 
 
After installing the dependencies, the wizard will prompt you to restart PyMOL so that the changes can take effect. 
Close and re-open PyMOL to continue.  
Select Surflex-Dock under the Plugin menu in PyMOL again. 
Click Next on the Setup Wizard. You will see a message that all required Python packages are installed.  
Click Next to proceed to the Surflex configuration. 
 
The wizard will prompt you to browse to the path containing the Surflex executable files and your Surflex license (see 
Section 2.1 for information about how to obtain these files).  
 
Click Browse next to the Executables line of the 

wizard and navigate to the folder on your 
computer that contains the Surflex 
executables (sf-tools.exe and sf-dock.exe) 
and click Open. 

 
Hint: by default, the Surflex executables are 
found inside the folder SF-Full-Distribution-
vX.XXX inside the bin folder; select the folder in 
the bin directory that is appropriate for your 
operating system). 
Click Browse next to the License line of the 

wizard and navigate to select the Surflex 
license file (surflex_bin.lic) on your computer 
and click Open. 

Click Finish to close the Setup Wizard. 
  



         7 

2.3 Running the Surflex-Dock plugin for PyMOL 

To open the Surflex-Dock plugin in PyMOL: 
Select Surflex-Dock under the Plugin menu in PyMOL.  
 

 
 
To dock the Surflex-Dock plugin window inside the PyMOL viewer on Windows: 
Double-click on the title bar of the Surflex-Dock plugin to dock the plugin.  
Click the windows icon  at the top right of the Surflex-Dock plugin to return the plugin to its own window. 
 
To dock the Surflex-Dock plugin window inside the PyMOL viewer on Mac: 
Click and drag on the title of the Surflex-Dock plugin and drag to the left or right side of the PyMOL display. 
Click and drag on the title of the Surflex-Dock plugin and drag it to the centre of the screen. 
 
On Linux, the plugin will always be docked to the main display and cannot be detached to a separate window. 
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2.4 Surflex-Dock plugin settings  

The settings for Surflex-Dock can be 

changed using the  button found at the 
bottom-right of the plugin window. In the 
Surflex tab, you can point to new locations 
for the Surflex executables and/or license 
file, as needed. In the Preferences tab, you 
can set default visualisation behaviour for 
showing waters associated with the protein 
and non-polar hydrogens on ligands.  
 
 
 

2.5 Uninstalling the Surflex-Dock plugin for PyMOL 

To uninstall the Surflex-Dock plugin: 
Open the Plugin Manager under the Plugin menu 

in PyMOL.  
Within the Installed Plugins tab of the Plugin 

Manager, click Uninstall next to the Surflex-
Dock plugin. 

To perform a complete removal of all plugin files 
and enable a fresh installation, you will also need 
to delete the configuration file 
.pymolpluginsrc.py in the user’s home directory 
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3. How do I… create or open a project 

3.1 Creating a docking project 

Open the Surflex-Dock plugin (see Section 2.3).  
Click New in the Surflex-Dock window.  
Type a name for your project in the Project title box. 
In the Folder name box, type the name to use for the new directory where project files will be saved; this will create a 

new directory with that name that will hold all of the project files. 
Browse to select the folder where you would like the project directory to be saved in your filesystem and click Open.  
Click Create project.   
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3.2 Saving a docking project 

Surflex-Dock automatically saves your work in the directory specified when you created the project (see Section 3.1). 
There is no manual control for saving a docking project; all files are saved as you work and will be restored 
automatically when opening the project. Any custom visualisations made in PyMOL will not be saved as part of the 
Surflex-Dock project. You can save the PyMOL session separately (see Section 8.3). 

3.3 Opening a docking project 

To open a Surflex-Dock project:  
Open the Surflex-Dock plugin (see Section 2.3).  
If you have recently worked on a project, the 
project directory will appear in the Recent 
projects panel of the Surflex-Dock window. 
Click on the recent project you would like to open. 
Click Open Recent at the bottom of the Surflex-

Dock window. 
 
To open a project that does not appear in the 
Recent projects panel of the Surflex-Dock 
window: 
Click Open in the Surflex-Dock window. 
Browse to the project folder that you would like to 

open. 
Click on the project folder in your file system to 

select the project. 
Click Open.  
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3.4 Closing a project 

When finished with a project, you can close the project and open another project.  
Click on the Project tab of the plugin. 
Click Close Project. 
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4. How do I… import and export data 

4.1 Importing ligands 

To prepare a ligand for docking, switch to the Ligand preparation tab in the plugin. 
Click on the Ligand preparation tab in the 

plugin.  
Click Open to import the ligand(s) in MOL2 or 

SDF format or as a list of SMILES strings.  
 
Note: If using a text file in SMILES format for 
input, put one SMILES string per line, with the 
compound name or identifier separated by a 
space after the SMILES string.  
 
To add a ligand manually, paste the SMILES 

string for the ligand into the SMILES… box 
in the plugin and click Import. You can 
paste multiple SMILES strings into the 
import box, separated by commas, and 
they will automatically be named lig, lig_2, 
lig_3, etc. 

 
Regardless of the input format, 3D coordinates 
will be generated for each ligand. You can 
control the behaviour of protonation, charge 
manipulation, enumeration of chiral centres, 
and geometry optimisation. The behaviour of 
these functions is described in Section 2.3 of 
the Surflex Manual.  
For each ligand, a conformation search is 
performed using parameter selection 
schemes, available from the pull-down menu in 
the Conformer search area of the Import 
Ligands wizard. The behaviour of these 
parameter schemes, with additional options 
for handling chiral centres and torsional 
constraints (e.g., from an NMR experiment), is described in Section 2.4 of the Surflex Manual. 
 
When you have finished selecting your import options, click Import. 
 
 
 
 
 

https://optibrium.com/BioPharmics/Surflex-Manual
https://optibrium.com/BioPharmics/Surflex-Manual
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4.2 Importing protein structures 

To import and prepare protein structures for 
docking, switch to the Protein preparation tab in 
the plugin. 
Click on the Protein preparation tab in the 

plugin.  
Type or paste a comma-separated list of PDB 

codes and click Import to download and 
import the protein(s) directly from the Protein 
Data Bank. 

To add a protein from a local file, click Open and 
browse to select the file(s) to import. 

 
Ligand verification is an important preparation 
step performed by Surflex-Dock during protein 
import. In published structures, it sometimes 
happens that the coordinates identified for the 
ligand in the X-ray structure do not match the 
SMILES for the ligand (some atoms may be 
missing or unable to be assigned in the X-ray 
density maps). During protein preparation, 
Surflex-Dock checks each ligand structure from 
the PDB against its SMILES and will display 
“quality ligand” in cases where the structure and 
SMILES match and “ligand” otherwise. It is 
recommended to use only qualified ligands to 
guide docking experiments.  

4.3 Exporting docking results 

Surflex-Dock automatically saves all your work in the directory specified when you created the project (see Section 
3.1). There is no manual control for saving or exporting results from a docking project.  
Docking results are saved in the project working directory (see Section 3.1) in MOL2 format with files named: 

<ligand>_docking_results<i>.mol2 

These files can be opened in StarDrop to give one pose per line, along with the pose number, pose family and 
probability, and the docking score (in units of pKd). 
 
Docking results can be exported to a text or spreadsheet editor (e.g. MS Excel) using Ctrl+C and Ctrl+V. 
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5. How do I… prepare proteins for docking 

Protein import (see Section 4.2) will load the 3D conformation of the protein and associated ligand, if available. 
Surflex-Dock will attempt to verify that the ligand structure matches the SMILES string provided with the structure. 
Additionally, the protein and ligands will be prepared for subsequent docking, including the identification of 
appropriate protonation states. 

5.1 Aligning and clustering 
protein structures 

 
For proteins with associated ligands, it is necessary to 
align and cluster the proteins to prepare for docking. 
Click on the Protein preparation tab.  
Click Align & Cluster All. 
Note: Only proteins with associated ligands can be 

clustered.  
 
The protein conformations are aligned using the 
electrostatic and steric representations of the binding 
pocket surface, defined by the volume around the 
bound ligand. This differs from conventional 
alignments that use the protein backbone; this binding 
site alignment provides a better template to guide 
docking experiments and 3D design. 
Note: Proteins within an identified cluster will be 
aligned to one another. Different clusters will not be 
aligned to one another and should be visualised 
separately.  
 
It is recommended whenever possible to use only 
quality ligands for clustering, as other ligands can 
have significant errors in them that can skew docking 
results (see Section 4.2). 
 
After the clustering job is finished, the cluster with the 
most proteins will be displayed automatically.  
Click Cluster 1 to open a drop-down menu and view 

other clusters.  
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5.2 Detecting cavities in protein structures 

For proteins without associated ligands, docking can be performed into cavities in the protein surface. 
Click on the Protein preparation tab. 
Select the proteins for cavity detection.  

– Use Ctrl+click and/or Shift+click to select specific proteins. 
– Click Select above the protein list and choose Proteins to easily select all proteins. 

Click Find Cavities. 
 

 
 
Note: Proteins without ligands will not be aligned during cavity detection. To visualise the cavities for multiple 
homologous proteins, it is recommended to align the protein structures before performing the cavity detection.  
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5.3 Selecting ligands and generating protomols for docking 

Automatically selecting ligands for ensemble docking 

It is often desirable to dock into multiple structures in a single experiment, i.e. ensemble docking to account for the 
dynamic flexibility of the binding pocket and avoid being led astray by the peculiarities of a single pose. Because the 
time required for docking increases with the number of protein conformations used, it is often convenient to choose 
a representative subset of structures to use for ensemble docking. While it is tempting to choose the most diverse 
structures, this can allow outlier variants to dominate the docking. Instead, it is recommended to choose the central 
exemplars of the most distinct clusters identified during alignment (see Section 5.1). In Surflex-Dock, this is 
implemented as the choose_k function (see Section 3.3 of the Surflex Manual). 
 
Surflex-Dock can choose an optimal subset of 
ligands that have been aligned and clustered to 
use for docking. 
Click Choose K in the Protein Preparation 

window 
Enter the size of the desired subset. 
Click Choose Subset. 

Manually selecting ligands for ensemble 
docking 

You can manually select the ligands or cavities 
which you want to use for docking. 
Use Ctrl+click and/or Shift+click to select 

specific ligands or cavities. 
Click Select above the protein list to easily 

select all ligands or cavities.  

https://optibrium.com/BioPharmics/Surflex-Manual
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Generating protomols 

The 3D shape and properties of the binding site are defined as a protomol (see Section 3.4 of the Surflex Manual). The 
docking algorithm will dock ligands into these protomols. To generate a protomol for a ligand binding site: 
Select the ligand(s) or cavities for which you want to generate the protomol(s). 
Click Generate Protomols.  
 
Note: docking results may be different for protomols generated separately (e.g. selecting one ligand at a time to 
generate the protomol) or together (e.g. selecting multiple ligands at once to generate protomols) because the union 
of the surfaces of all selected ligands is used for protomol generation.  
 

  

https://optibrium.com/BioPharmics/Surflex-Manual
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6. How do I… perform a docking experiment 

6.1 Docking ligands into protomols 

To perform a docking experiment: 
 
Change to the Docking tab in the plugin.  
Click Dock at the bottom of the plugin window to 

open the Docking wizard. 
Select the protomols (grouped by cluster, see 

Section 5.3) to dock against and click Next. 
Select the known ligands to use as docking 

templates, and for pose family identification. 
Use Ctrl+click or Shift+click to select multiple 
ligands.  

Click Next. 
 
Note: It is recommended to use only qualified 
ligands for docking and pose identification (see 
Section 4.2). 
 
Select which ligands to dock. Use Ctrl+click or 

Shift+click to select multiple ligands. 
Click Next. 
Choose the desired docking mode (see Section 3.7 of the Surflex Manual for a description of the available docking 

modes and their intended uses).  
Set any desired constraints (see Section 7). 
Click Dock. 

6.2 Viewing docking results 

Multiple docking runs in the same project can be accessed using the pull-down menu at the top-left of the Docking 
tab, organised by the name of the protein-ligand pair or protein cavity used to generate the protomol. The top panel of 
the Docking tab displays the docked ligands with a summary of the docking results, including the name of the ligand, 
the number of distinct pose families identified, the number of unique poses, the probability of the most likely pose 
family being correct and the top docking score (in units of pKd). The bottom panel of the Docking tab shows the pose 
families and unique poses for each docked ligand, including the family number, pose number, probability of that 
docking family being correct, and the docking score for each pose (in units of pKd).  

https://optibrium.com/BioPharmics/Surflex-Manual
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To view the docking results:  
Select the docking experiment for which you wish to view the results from the drop-down menu at the top left of the 

plugin.  
Select the docked ligand from the list in the top panel of the Docking tab to view the docked poses and pose families 

for that ligand. 
Select the pose family or individual pose in the bottom panel of the docking tab to explore the docked poses. 
Toggle the Pin button to the left of each pose to keep poses of interest displayed in the viewing window. 
At any time, you can display protein structures, cavities, known ligands, and/or protomols along with the docking 
poses using the Show/Hide protein controls button.  
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7. How do I… use constraints 

In some cases, a user has knowledge about the likely conformation of a substructure within a molecule (e.g., from 
detailed energetic calculations) or about a molecule’s likely bound configuration. In such cases, it may be desirable 
to make use of constraints on molecular pose during conformer generation and/or docking. Details concerning the 
use of torsional or positional constraints can be found in Section 2.6 of the Surflex Manual. 
 
To use constraints during conformer generation or docking, you will first need to import the template ligand as 
described in Section 4.1.  
Choose Atoms as the Selection mode under the Mouse menu in PyMOL. 
 

 

https://optibrium.com/BioPharmics/Surflex-Manual
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Import your ligand(s) using the SMILES box or the 

Open file dialog. 
Click on the pull-down menu next to Torsional 

Constraints.  
Select whether you will upload a constraints file 

or manually select constraints on the 
display. If you choose to read constraints 
from a file, Browse to select and upload that 
file. 

Click Next.  
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Select the template ligand from the list of ligands in the Ligand preparation tab. The template ligand will be 
displayed with atoms numbered in the PyMOL display 

Click Choose ligand. 
• Hold the Shift key and click with your mouse to create a box around the atoms you want to use to define the 

constraint. 
Click Add Fragment.  
Click Import to import your ligand(s) using the torsional constraints. 
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8. How do I… troubleshoot problems 

8.1 Installation problems 

Issue: The Surflex-Dock plugin is not functioning or is not loading in my PDB files.  
Check the Surflex.exe file is saved locally on the machine and not on a cloud-based drive (eg., Onedrive). 
 
Issue: The Surflex-Dock plugin doesn’t start, showing the error message “An error occurred when trying to initialise 
the plugin”. 
 

 
 
This can happen if you update PyMOL using the option Help->Check for Updates, but it starts using an unsupported 
Python version. Use the following commands to check the Python version PyMOL is using: 
 
import sys 
print(sys.version) 
 
Then, ensure that you only have Python 3.10 installed by uninstalling any other Python version and re-install PyMOL. 

8.2 PyMOL crashes  

PyMOL crashes are occasionally observed when using the Surflex-Dock plugin. We have done our best to investigate 
and mitigate these events; because the crash arises from the underlying PyMOL code and not the plugin itself, it is not 
always straightforward to diagnose or resolve. If you experience crashes, please send the crash report and log files 
for the PyMOL session to support@optibrium.com and we will be happy to investigate. 

mailto:support@optibrium.com
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8.3 Saving and restoring a PyMOL session 

It is not recommended to alter the visualisations in PyMOL while using the plugin; the plugin will override any 
visualisations made in PyMOL. After running all calculations, you can select or pin the structures of interest in the 
plugin to load them in the PyMOL visualisation state. Note that only the structures that are selected or pinned in the 
plugin will be available to view in the PyMOL interface. After selecting all structures of interest, you can close the 
Surflex-Dock plugin and customise the visualisation using the selection and display features in PyMOL.   
Any custom visualisations made in PyMOL will not be saved as part of the Surflex-Dock project. It is recommended 
to only use the Surflex-Dock visualisation tools while performing docking calculations. When you have completed 
the calculations, you can close the plugin and use PyMOL to make other visualisations. You can save and open 
PyMOL sessions under the File menu in PyMOL. 
You can also create visualisations in PyMOL (or another favourite visualisation program) by loading the output files 
from the Surflex-Dock plugin calculations. 
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